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セキュリティ・コミュニティ内で有名なイベントの 1 つが AVTOKYO だ。「no drink, no hack」を
標榜し、コミュニティ主導で企画・運営されている。今回、話を伺う tessy こと寺島崇幸氏は、
AVTOKYO の企画・運営の中心にいる人物。2000 年代初頭よりコミュニティ内で積極的に活動を続
け、CTF チームを結成。DEFCON CTF 本戦への出場を数回にわたり実現したり、マレーシアで開催
された国際大会では 2 度の優勝を果たしたりするなど、数々の成果を残してきた。今回は、tessy
さんの話を通じて、セキュリティ・コミュニティを振り返りつつ、11 月開催の AVTOKYO2023 の話題、
そして tessy さん自身の信条などについても触れてみたい。

tessy（寺島崇幸）インタビュー

AVTOKYO の開催や国際 CTF 大会への挑戦を通して
セキュリティ・コミュニティをリードしてきた

取材・文＝吉澤亨史
撮影・編集＝斉藤健一
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… たまたま入った会社がセキュリティだった

吉澤（以下  ）：まず、tessy さんの経歴につい
てお願いします。
tessy（以下  ）：大学は北海道で、しかも農学部
でした。特に農業をやりたかったというわけでは
ありませんでしたが、トラクターなどの農業用機
械や農産物加工などについて学びました。卒業後
に就職したのは自動車の部品を CAD で設計する
企業でした。情報系には全く縁がなかったのです
が、学生時代に触れたインターネットに携わる仕
事への思いが強くなり、ネットワーク系の企業に
転職することにしました。

 それはいつ頃のことですか。
  2001 年のことです。そして、この企業がセキュ

リティをサービスとして立ち上げることとなり、
勉強会に参加したり、書籍を読んだりして研さん
を始めました。これがセキュリティとの最初の関
わりです。

 たまたま入った会社でセキュリティに関わった
ことがきっかけ、というのも興味深いですね。

 入社した当時はネットワークの知識しかなく、
Nmap さえわからない状況でした。ですが、セキュ
リティ診断やセキュリティの教育コンテンツを
作ったり、実際に教えたりしていました。セキュ
リティプロダクトの部署はあったのですが、新た
にサービスを作るということで、未経験でしたが
いろいろなことに挑戦しました。

 業務以外の活動はいかがでしたか。
 日経 BP が主催する「WPC EXPO 2002」の中で

「セキュリティ・スタジアム 2002」というイベン
トに参加しました。一般から応募した参加者たち
が「攻撃」「防御」「検知」の 3 つのクラスに分か
れ、腕を競い合うものでした。これを皮切りに、
さまざまなセキュリティイベントに参加し始めま
した。また、ブログでセキュリティ情報などを発
信するうちに、知人も増えていきました。

… CTF への挑戦は
… DEFCONというお祭りをより楽しむため

 2000 年代、tessy さんはチームチドリとして活

動されていたかと思います。まずこのチームにつ
いて教えてください。

 2002 年頃、仲の良い 5 ～ 6 人の仲間で活動し
ていました。そこには、私のほかにもう 1 人の「寺
島」さんがいて、ダブル寺島だったわけです。チー
ム名を考えるときに、最初は「T 島」という案も
出たのですが、「島」だと面白くないということ
で「T 鳥」となり、それが「チドリ」になったの
です。

 Twitter（現：X）のアイコンに家紋の「千鳥紋」
が使われていますが、そういったいきさつがあっ
たのですね。

 は い。 チ ド リ で 初 め て DEFCON に 参 加 し た
のが 2005 年でした。このときはまだ CTF には
参戦せず、仲間でワイワイと楽しんでいました。
DEFCON には、「WALL of SHEEP」というコーナー
があり、暗号化せずに通信している人のパスワー
ドが会場にさらされます。私たちはこれを逆手に
とり、平文でパスワードを送ってしまったふりを
して架空アカウントのパスワードを表示させる遊
びをしていました。

 なるほど。発想の逆転ですね。
 CTF に は 翌 年 の 2006 年 か ら 参 加 し ま し た。

寺島崇幸（てらしま・たかゆき）
2001 年からネットワーク、システムのセキュリ
ティなどの仕事に携わる。現在は株式会社ディ
アイティに勤務。DEFCON CTF 本戦にはじめて出
場した日本チーム sutegoma2 のリーダーを務め
る。2008 年よりコミュニティ主導によるセキュ
リティイベント AVTOKYO を主催。2012 年より
SECCON 実行委員会に参画。副実行委員長を経て、
現在はアドバイザーを務めている。
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DEFCON というお祭りをもっと楽しみたいという
気持ちからです。これも飲み会の席で「出よっか」
という軽いノリで決まったのです。

 もともと海外に行く機会は多かったのですか。
 実は海外は苦手でした。2000 年頃、最初の会

社で 2 ヵ月間ほどアメリカとベルギーに行かされ
たのですが、嫌で嫌でしかたありませんでした。

 現在の tessy さんからは想像できない答えです
ね。

 この気持ちが変わったのは、自身でセキュリ
ティ情報を収集するようになってからです。セ
キュリティ業界では、一次情報は海外からの発信
がほとんどです。また、海外のカンファレンスに
行けば、Windows の脆弱性の話を発見者から直
接聞くこともできます。そこで、2006 年ごろから、
マレーシアのセキュリティカンファレンスに行く
ようになったのです。実は、当時在籍していた会
社が倒産し、半年間ほど自由の身だったという理
由もありましたが。

 そういった経緯があったのですね。
 マレーシアのセキュリティカンファレンスで

は、CTF も開催しているのですが、DEFCON とは
違い、当日会場に行けば参加できるものでした。

「出場して腕試ししたい」と、毎年、いろいろな
人に声をかけて参加しました。実際に、日本から
チームとして出場したのは sutegoma2 になった
ときでした。

 sutegoma2 になったのは、いつ頃でしたか？
 sutegoma2 をチーム名としたのは 2008 年から

です。これまでチドリで DEFCON CTF 本戦出場を
目指していたのですが、やはり世界の壁は高く、
なかなか予選を突破できずにいました。そんなと
き、「DEFCON CTF プロジェクト」として本戦出
場を目指す機運がコミュニティ内で高まってきた
のです。それまでの複数チームを一本化した合同
チームの結成や、勉強会の本格化などに取り組ん
でいきました。

 その合同チームが sutegoma2 なのですね。
 はい。sutegoma2 の由来をお話すると、当時

の DEFCON CTF の予選ではルール上、アカウン

トをたくさん持っているチームの方が有利だっ
た の で す。 そ こ で、sutegoma、sutegoma2、3、
4、5 と数多くのアカウントを作っていたのです
が、CTF 運営側のトラブルで多くのアカウント
が消えてしまったことがありました。そんな中、
sutegoma2 だけが残ったのです。

 それは幸運でしたね。
 はい。これは縁起がよいということで、そこか

ら sutegoma2 がチーム名となりました。後々に
なって「私たちは若い人たちの捨て駒、踏み台に
なる」という意味ですと語るのですが、きっかけ
はそんな形でした。

 sutegoma2 の戦績について教えてください。
 結成 4 年目の 2011 年に DEFCON CTF 予選で 2

位になり、初めて本戦に出場しました。このとき
は、多くの方々に支援していただきました。結果
は残念ながら最下位でしたが、同年の 10 月には
マレーシアの CTF で優勝しました。マレーシアで
は 2 回優勝しています。

 sutegoma2 は日本の CTF プレイヤーの底上げ
にも寄与したといえますが、当時に比べて、現在
の日本人プレイヤーのレベルは上がりましたか？

 何をもって判断するのかは難しいですが、国際
CTF 大会への参戦は sutegoma2 の活動によって
広がった側面はあると思います。DEFCON CTF や
韓国の CODEGATE   CTF などで決勝戦に駒を進め
ることで、多くの経験を積んできました。このこ
とが、「binja（ビンジャ）」や「Tokyo Westerns」
をはじめとする次世代のチームへとつながってい
ると考えます。

… BlackHat…Japan の後夜祭から始まった
… 「AVTOKYO」

 それでは本題の AVTOKYO ※ 1 についてお聞き
します。アーカイブ※ 2 を見ると 2008 年からとなっ
ています。

 も と も と、BlackHat JAPAN が 2004 年 か ら
2008 年まで開催されていて、その打ち上げが起
源です。ラスベガスで開催している BlackHat USA 

※ 1 AVTOKYO https://www.avtokyo.org/
※ 2 AVTOKYO 日本語アーカイブ https://ja.avtokyo.org/
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に行った日本人たちが飲み会をするような感覚で
「After Vegas」、 略して AV と 2007 年頃から呼ぶよ

うになりました。
 なるほど。AV にはそういう意味があったので

すね。
 2007 年の BlackHat JAPAN 終了後、新宿の飲食

店で、プレゼンをしながらワイワイと盛り上がっ
ていると、BlackHat 創設者のジェフ・モスさん
がスピーカー数名とともに会場に来てくれたので
す。 これは、当時 BlackHat JAPAN のオペレーショ
ンを担当していた篠田佳奈さん（現 CODE BLUE 
事務局代表）の尽力によるものです。

 それはさらに盛り上がりますね。
 はい。英語は話せなくても一緒に飲めば楽しい

ですし、プログラムコードは彼らとの共通の言語
ですから、すぐに打ち解けることができました。
これが好評で、翌年からは日本発を掲げるために
AVTOKYO としました。2008 年は、昼夜に分けて
開催しました。昼間は HackerJapan を刊行してい
た白夜書房のホールを借りてプレゼンテーション
中心のデイ・セッションを行い、夜は「no drink, 
no hack」をスローガンに掲げてアフター・パー
ティを行いました。翌年からは、飲みながら・食
べながら参加できる形とし、クラブを貸し切って
開催する現在のようなスタイルになったのは 2011
年からです。

 企業の協賛を受けないのは、ポリシーがあるの
でしょうか。

 コミュニティ主導でベンダーニュートラルとし
たいという方針があるからです。実は、これまで
に何度か企業スポンサーについて検討はしていま
すが、その度に「なしで頑張ろう」ということと
なり現在に至っています。その代わり、AVTOKYO
の主旨に賛同いただける方に、個人スポンサーと
して支援をお願いしています。

 個人スポンサーには、どのようなメリットがあ
りますか。

 これまでは、スペシャルお土産アイテムをお渡
ししたり、参加バッジが豪華になっていたり、会
場でスポンサー名を掲載したりというものです。
あとはイベント後のスタッフの飲み会に招待して

交流できるといったことも行っています。
 AVTOKYO といえば、毎年凝ったバッジが作ら

れていますが、こちらについて教えてください。
 バッジは毎回オリジナルで、DEFCON のような

凝ったものを作っています。電子工作などが得意
な人たちが作成しています。大抵予算をオーバー
するのですが（笑）。過去にはサコシュを入場バッ
ジにしたこともありました。これは、アナログ
レコード盤を入場バッジとした DEFCON を越え
て世界最大のカンファレンスバッジとなりました

（笑）。もちろん、今年も世界初に挑戦します。
 AVTOKYO のグッズ販売ページ※ 3 でサコシュを

含めてさまざまな商品が販売されていますが、入
場バッジも販売したら売れるのではないでしょう
か。

 実は過去のバッジは在庫のあるものは Booth
（創作物のマーケット）で販売をしています※ 4。

 長年運営を続けてきて参加者に変化はあります
か。

 若い世代の参加者が増えるとともに、新規の参
加者も増えています。これはセキュリティに仕事
で関わる人が増えてきたからではないかと思いま
す。また、AVTOKYO では、講演に限らずワーク
ショップなども公募していて、近年、こちらへの
応募も増えています。

 参加者に限らず、AVTOKYO に関心を寄せる人
が増えているということですね。講演応募の倍率
はどれくらいですか。また、特徴のあるワーク

※ 3   AVTOKYO SWAG　https://suzuri.jp/avtokyo
※ 4  AVTOKYO ｰ Booth　https://avtokyo.booth.pm/ 

AVTOKYO 歴代イベントバッジ。一部は Booth などで販売されて
いる（写真提供：tessy さん）
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ショップなどがあれば教えてください。
 講演の公募は、例年 2 倍ほどの競争率です。内

容はテクニカルなものから「ネタ」的なものまで
幅広くなっています。酔っている参加者の前で
の講演は難しいと思います。ワークショップの方
は、ハンダ付けのようなハードウェアを扱ったモ
ノや、BlackHat ARSENAL のようなツールの紹介、
あと例年 Open xINT CTF が開催されています。

 話はそれますが、Open xINT CTF を主催する
pinja は、今年 DEFCON で開催された OSINT CTF

（Recon Village CTF）で見事優勝を果たしました
ね※ 5。

 はい。本当に快挙ですね。AVTOKYO の Open 
xINT CTF は、この 3 年ほどはコロナ禍でオンライ
ン開催でしたが、それ以前は現地会場で開催して
いました。答えとなるフラグを会場や渋谷の街か
ら探し出すなど、趣向が凝らされていました。

 AVTOKYO 2023 の目玉など、公開できる情報は
ありますか。

 今年はロックピッキング的な企画をやりたいと
考えています。物理的な鍵のハッキングですね。
ただし、日本では一般の人がピッキングツールを
所持することは違法にあたるため、鍵穴を探りな
がらブランクキーを削るワークショップを検討し
ています。これなら単なる金属加工ですから。

 かなり攻めた企画ですね。期待しています。
 他には、前述した Open xINT CTF の開催も決定

しています。先日の企画会議では、イベントを通

※ 5  優勝してきたぜ！ ハッカーイベント「DEF CON」OSINT CTF 体験記（ASCII）https://ascii.jp/elem/000/004/158/4158573/

じて「縁日感を出そう」ということで話がまとまっ
たので、きっと楽しいものになると思います。ま
た、今年は久々に前夜祭を開催しようかとも考え
ています。参加者が来ない可能性もありますが、
他ではできない「濃い話」をする場にしたいです
ね。あわせて、開催当日のアフター・パーティの
規模縮小も検討しています。まあ、飲みに行かな
いということはありませんが（笑）。

 tessy さんにとって、イベント運営の醍醐味は
何ですか。

 毎年、企画をスタートする春頃はあまりやる気
がないのです。一方、開催が近づくにつれて、今
度は準備が大変になります。AVTOKYO は基本的
に CODE BLUE などのイベントの後夜祭という位
置づけですから、スタッフはイベントで働きっぱ
なしで、前夜はだいたい徹夜で準備することにな
ります。ただ、AVTOKYO で皆さんがみんな楽し
そうにワイワイ飲んでいるのを見るのはうれしい
です。飲み会の幹事のような感覚ですね。それが
終了時にピークを迎えて「終了です！また来年！」
と、うっかり言ってしまうのです。「あっ、また言っ
ちゃった」って（笑）。

 逆に苦労するのは、やはり準備のときですか？
 準備も大変ですが、グッズやイベントなどの企

画面でも苦労します。毎回、何か面白いことをや
りたいと考えるのですが、行き詰まってしまいま
す。コロナ禍でリアルな飲み会がなくなり、くだ
らないネタが出てこなくなりました。ここ数年、
企画面では悶々としていましたが、先日、久しぶ
りにスタッフが集まり飲み会をしたところ、くだ
らない話がどんどん出てきました。やはり、対面
で人と会うのは重要です。

… AVTOKYO がなくなっても、
… やりたい人が新たな「場」を作ればいい

 今後、AVTOKYO をどのようにしていきたいで
すか。例えば、10 年後も続けていますか。

 先のことはわかりませんが、「もうやめようか
な」という考えは常にあります。運営が大変なの
で、少しでも楽にするために同じような仕組みに
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しているのですが、そうすると刺激がなくなって
しまうのです。ただ、AVTOKYO を誰かに引き継
ぐということは考えていません。なくなったとき
に、今度は誰かが新しいものを自由に作ればよい
と思っています。

 そうした考えの背景にはご自身の性格が影響し
ていると思いますか。

 そうかもしれません。個人的には、好きなこと
は仕事に限らずやっていく人生が目標です。一方
で制約を受けたり縛られたりすることは嫌なので
す。わがままなのだと思います。

 バイク（自転車）も海外遠征なさったりしてい
ますね。

 自転車は、社会人になったときに参加したトラ
イアスロンがきっかけです。大学時代に、山登り
か岩登りかトライアスロンをやりたいと、漠然と
思っていました。それまで文科系だったのに。そ
の後、北海道で山登りをしたので、社会人になっ
てトライアスロンに参加しました。最近また自転
車にはまっていて、コロナ禍では ZWIFT（バー
チャルサイクリングサービス）を始めて、体重が
10kg 落ちました。今年は 4 年に一度フランスで
開催される PBP（パリ～ブレスト～パリ）にも参
加し、無事に完走しました。その 1 週間後には、
ワインを飲みながらフルマラソンを走るメドック
マラソンにも参加しました。

 すごいですね。何か考えがあったのですか？
 人生を生きていくためには体力が必要だと思っ

ていまして。仕事もそうですが、忍耐力などには
ベースになる体力が必要なのではないかと、CTF
に参加した頃から少し思っていたのです。強い人、
続けられる人はやはりベースがあるので、それを

心がけています。まあ、もともと体を痛めつける
のが好きなのです。山を走ったりもしましたし。

 強靭な体力で、ますますコミュニティを引っ
張って欲しいと思います。今回はありがとうござ
いました。

（編注：AVTOKYO の企画内容はインタビューが行
われた 2023 年 9 月当時のものであり、11 月の開
催時には内容が変更になることがあります）

PBP 参加中の一枚（大会運営による撮影・販売）。tessy さん曰く
「PBP は長くて楽しい 1200km でした」とのこと
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… カナダで可決された
… Online…News…Act について

【概要】カナダ政府は、2023 年 6 月下旬、Meta や
Google などに対して、カナダに関わるニュースリン
クを表示させるだけで利用料を課す法案「Online 
News Act」を可決した。本法案に関連して、カナ
ダ国内での影響や諸外国への影響について考察す
る。

【内容】2023 年 6 月 22 日、カナダ政府は、カナダ
のメディアを保護する法案「Online News Act」を
可 決した。 この 法 案 は、Facebook、 Instagram、
Google ニュースなどにカナダに関わる記事が掲
載される際に、プラットフォームの提供元である
Meta や Google に対し、記事提供元であるカナダ
のメディアへ利用料支払いを義務付ける内容であ
る。これを受け、同日に Meta は、カナダ国内の全
ユーザー向けに Facebook と Instagram でのカナダ
に関わるニュースの提供を終了すると発表した。さ
らに 6 月 29 日には、Google もカナダ国内でカナ
ダのニュースを Google 検索や Google ニュースか
ら遮断することを発表した。
　法案可決の背景には、各メディアの定期購読や広
告収入が減少し、デジタルプラットフォームへシフ
トしている状況を鑑みて、プラットフォームとメディ
アの経済的公平性を確保する目的がある。カナダ
政府は、大手 IT 企業が彼らのプラットフォームに無
償でニュースを掲載することで、ユーザーを集めて
膨大な広告利益を得ていると懸念している。一方、
この法案に対して、Meta や Google は懐疑的であ
る。なぜなら、Google は多くのメディアに「ニュー
スショーケースプログラム」を無償で提供している
からだ。このプログラムでは、提供元ごとに「パネル」
で記事が表示され、ニュースの提供元が自ら記事

HISYS…CSI（Cyber…Security…Intelligence）Watch…2023.10

を直接届けられたり、記事の掲載方法やブランディ
ングをコントロールしたりすることができる。これ
を利用することで、読者をニュースの提供元の Web
サイトに誘導でき、双方の関係性を深める役割をし
ていると考えるからだ。さらに、Google は、この
プログラムでカナダのメディアは年間 250 億円の収
益を上げると試算している。また、Meta も同様に、
プラットフォームにニュースを載せることでカナダの
メディアは約 230 億円の広告収入を得ていると主張
している。
　2023 年 7 月初 旬、 この 法 案 の可 決 を 受 けて、
Meta が運営する Instagram において、一部のユー
ザー向けにカナダのニュース表示が試験的に削除
された。削除の対 象には、以前 検 索、フォロー
したニュースのコンテンツも含まれている。また、
Google は、Metaと同様に12 月19 日までにはニュー
スページへのアクセスを停止する予定だが、緊急性
の高い情報については対象外とする姿勢だ。2021
年、オーストラリアでも同様な法律が可決され、
Meta が一時的にニュースへのアクセスを停止した時
期があった。しかし、後に合意に至り、Meta と報
道機関の間でコンテンツ取引が成立したためカナダ
も同様の道を辿るかもしれない。
　一方、この法案は、カナダの管轄外の仲介業者
にも影響を与える可能性がある。例えば、インター
ネット上のサービス運営者は、カナダからのユーザー
やニュースコンテンツのためにサービスの仕組みを
変更する可能性もある。その結果、インターネット
上のサービスは、カナダ国内外で別の仕様で機能し、
諸外国と比べてカナダ国内のユーザーは関連したコ
ンテンツへのアクセスが減少する。この状況がビジ
ネスに不利に働くと考える企業は、事業やサービス
をカナダから撤退し、法律遵守のコストを回避する
ことを検討するだろう。今後この法案がどうカナダ
国内で施行、運用されていくのかは確認していく必
要がある。

文＝ SHIELD Security Research Center

社会のさまざまな動向を把握し、リスクの変化に対応したセキュリティ体制を構築社会のさまざまな動向を把握し、リスクの変化に対応したセキュリティ体制を構築

HISYS…CSI（Cyber…Security…Intelligence）Watch…2023.10

［情報源］https://www.cbc.ca/news/editorsblog/cbc-online-news-act-1.6897060
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セキュリティツールを実践的に紹介する連載企画

Let's Try Windows システム確認！
2．プロセス確認編

文＝ SHIELD Security Research Center

1．はじめに

　本稿は、各種セキュリティツールを実践的に紹介する連載企画です。前号より第二部「Windows シス
テム確認」と題し、Microsoft 社が提供する「Sysinternals Suite」として利用可能な、いくつかのツール
の使い方を確認します。
　「Sysinternals Suite」は、多数のトラブルシューティング ユーティリティをまとめたバンドルです。誰
でも無償で利用することができ、Windows マルウェアの動的解析などにも利用可能なツールです。
　「Sysinternals Suite」を有効活用することで、コンピューターに感染した Windows マルウェアを見つ
け出したり、Windows マルウェアの挙動を確認したりすることができます。
　一方、「Sysinternals Suite」が動作するコンピューターでは、活動を停止する Windows マルウェアも
存在します。
　「第二部　Windows システム確認」は次の 3 部構成となっています。

1. 自動起動プログラム確認編
 Autoruns を利用して、Windows の自動起動プログラム設定を確認します。

2. プロセス確認編
 Process Monitor を利用して、Windows 上で起動するプロセスの動きを確認します。

3. ネットワーク状況確認編
 TCPView を利用して、Windows 上でのネットワーク状況を確認します。

　今回は、「2. プロセス確認編」として、Windows プロセスのアクティビティ（挙動）の確認方法を解
説します。マルウェアの挙動確認、マルウェアの感染確認（ロードされる DLL として）などに利用可能
となります。
　本稿の安全性には留意していますが、安全を保証するものではございません。
OA 端末（社内ネットワーク接続機器）で実施するのではなく、分離された回線内および機器を利用す
ることを推奨いたします。
　なお、本稿は「自動起動プログラム確認編」と同様、Windows Sandbox を利用した手順での解説を
予定しておりましたが、Windows Sandbox 上では「Process Monitor」の動作が不安定であることを確
認しております。そのため、今回の「プロセス確認編」では、ローカル環境（専用マシーン）または
VMWare などの仮想環境を用いて実践することをお勧めいたします。



11

2.…準　備

2.2…Putty の準備
「Putty （パティ）」は、Simon Tatham が MIT License （オープンソースソフトウェアライセンスの一種）

で開発・公開しているリモートログオンクライアントです。
後ほど、「Putty」を使った確認手順がありますので、準備をしておきます。ソフトウェアは以下の
URL よりダウンロードできます。

・「Putty」
　https://putty.org/

筆者は下記、64-bit x86 binary file をダウンロードしました。ご自身の環境に合わせてダウンロード、
ご準備してください。

2.1…Process…Monitor…の準備
「Process Monitor」とは、「Sysinternals Suite」に含まれる、Windows で実行中プロセス（プログラ

ム）の挙動を確認するためのツールです。
「Process Monitor」および「Sysinternals Suite」は下記などから、ダウンロードすることができます。

･「Process Monitor」
　https://learn.microsoft.com/ja-jp/sysinternals/downloads/procmon

・「Sysinternals Suite」
　https://learn.microsoft.com/ja-jp/sysinternals/downloads/sysinternals-suite

今回は、筆者は Procmon64.exe を利用します。読者の皆様は、利用されている環境に合わせて、選
択してください。
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3.…プロセス（プログラム）の確認

3.1…「Process…Monitor」の起動テスト
「Process Monitor」を起動します。
「Process Monitor」を起動すると、プロセスのアクティビティが大量に記録され始めます。

Windows のさまざまなプロセスは常に動作を続けているため、このままでは、大量のアクティ
ビティが記録されることとになります。いったん、図のボタン❶を押下し記録を停止し、ボタン
❷を押下しこれまでに記録されたアクティビティを削除します。

アクティビティを削除したら、起動テストは完了です。

3.2…Putty の起動、リモートサイトへの Telnet（HTTP 接続）テスト
次に、「Putty」を利用した Telnet（HTTP 接続）のテストを実施します。
準備した「Putty」を起動します。
図の通り、Session タブの Host Name に「www.hitachi-systems.com」、Port に「80」を入力し、
Connection Type を Other で「Telnet」を選択し、Open ボタンを押下します。
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3.3…アクティビティの記録
それでは実際に、「Process Monitor」を用いて、「Putty」のプロセスのアクティビティを記録して
きます。図のボタン❶を押下し、「Process Monitor」によるプロセスのアクティビティの記録を開
始します。

起動すると、黒いプロンプト画面が表示されます。

プロンプトが表示されましたら「GET . HTTP/1.1」を入力します。これは、Web ページなどにアク
セスした際に、通常ブラウザーが行っている HTTP リクエストのうちの、リクエストラインを表し
ています。

入力後、「Enter」を押し、HTTP レスポンスが一瞬だけ表示され（表示が見えない場合もあります）、
プロンプト画面が閉じたら、確認は終了です。
HTTP レスポンスがいつまでも返ってこない場合には、通信路上に問題がある可能性がありますの
で、確認してください。
なお、HTTP レスポンスの内容については、確認をする必要はありません。

下図のようにアクティビティの記録が始まっていることを確認します。
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次に、3.2 で実践した「Putty」を用いた Telnet 接続（HTTP 接続）を、今一度実施します。
この時、次のように、「Saved Sessions」に「hitachi-systems」と入力し、「Save」ボタンを押下してから、
Open ボタンを押下してください。

Telnet 接続が完了したら、下記のボタン❶を押下し、「Process Monitor 」によるプロセスのアクティ
ビティの記録を停止します。



15

3.5…プロセスツリーの確認
「Process Monitor」は、Windows で動作している多くのプロセスに関わるアクティビティを記録し

ます。そのため、必要な情報のみに絞って確認することが必要となります。その１つの方法が、画
面出力内容のフィルター機能です。
フィルターを設定する方法はいくつかあるのですが、今回はもっとも簡単な手法として、プロセス
ツリーを用いて、確認を行いたいプロセス「Putty」の特定を行い、フィルター設定を行ったうえで
アクティビティを確認していきます。

「Process Monitor 」のメニューバーより、「Tools->Process Tree」を選択します。

3.4…アクティビティの保存
次に、アクティビティをログとして保存します。
メニューバー「File->Sava」を選択すると、Save To File ダイアログが開きます。保存する場所「Path」
を適宜変更し、OK ボタンを押下して保存します。
設定項目がいくつかありますが、今回はデフォルト設定（初期状態）で問題ありません。
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「Process Tree」を開くと下記のような画面が表示されます。時系列で起動していたプロセスを確認
することができ、プロセスの親子関係も確認できます。

プロセスツリーより、「Putty」をさがし、右クリックから「Add Process to Include filter」を選択
します。
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3.6…レジストリアクティビティの確認
「Putty」プロセスの、レジストリに関するアクティビティを確認します。

下の図の❶のみが有効 ( 背景が水色 ) の状態となるように設定します。

選択が終わると、PID（プロセス ID）でフィルターに追加が行われます。「Process Monitor」の画
面上に「Putty」のアクティビティのみが表示されていることを確認してください。

下の図と同じように、「Putty」プロセスのレジストリに関するアクティビティのみが表示されたこ
とを確認します。
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次に手動で Filter を設定します。
メニューバーの「Filter->Filter」を選択します。
その後、条件に「Path」「contains」「hitachi-systems」「then」 「Include」を設定し、Add ボタン
を押下し、フィルターを追加します。

フィルターを設定すると Path に「hitachi-systems」の文字列が含まれるアクティビティのみが表
示されます。
そして、Path「HKCU\SOFTWARE\SimonTatham\PuTTY\Sessions\hitachi-systems」に対して RegCreateKey
を行っていることが確認できます。これは、「Process Monitor」で「Putty」が保存したセッショ
ン情報をレジストリーキ―に保存する過程のアクティビティとして記録したものになります。

確認ができましたら、次の作業のため、設定したフィルターのチェックボックスを外し、「OK」を
押下し、フィルター条件から削除してください。
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3.7…ファイルアクティビティの確認
「Putty」プロセスの、ファイル操作に関するアクティビティを確認します。

次の図の❶のみが有効（背景が水色）の状態となるように設定し、「Putty」プロセスのファイルに
関するアクティビティのみが表示されたことを確認します。

次に、「Operation」が「CreateFile」となっている行を探し、右クリックから「Highlight ‘CreateFile’」
を選択します。
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6．…おわりに

3.8…ネットワークアクティビティの確認
「Putty」プロセスの、ネットワークに関するアクティビティを確認します。

次の図の❶のみが有効 ( 背景が水色 ) の状態となるように設定します。
また、「Putty」プロセスのネットワーク関するアクティビティのみが表示されたことを確認します。 

選択が終わると水色で「CreateFile」のみがハイライトなされます。フィルターとは違い、全体の
アクティビティを確認しながら、着目したい箇所のみに焦点を当てる有効な手法となります。

「putty」が、「202.222.240.168」に HTTP 接続をしていることがわかります。「202.222.240.168」は、
www.hitachi-systems.com に関わる IP アドレスです。「Process Monitor」が「Putty」で Telnet 接
続（HTTP 接続）した通信記録を、アクティビティとして記録していることが確認できました。

　今回は、「2. プロセス確認編」として「Sysinternals Suite」に含まれる「Process Monitor 」を用いた、
Windows プロセスのアクティビティ（挙動）の、レジストリ・ファイル・ネットワークの確認方法を確
認しました。
　マルウェアに感染していることがわかり、マルウェアのファイル名などがわかっている場合は、マル
ウェアの挙動の記録、詳細を確認することが可能です。
　次回は、同「Sysinternals Suite」に含まれる「TCPView」を用いて、ネットワーク通信状況の確認方
法を確認します。


